Unl all c m hips in the game
nlock ’ uschamp s ips
Leave the oppos on standing [
Unl and high s toy rs
Get into the groove and in the slot racing championsh'p

Make your car impervious to da and deal out
some punishment

Cheats affecting car performance damage cannot be used while playing online.
Note: All of these can also be unlocked by playing through the game.

To o in th us log o

or call

lis st $2. 9 r i t

Calls from mobiles vary. Callers must be over 16 and have permission from the bill payer. Prices corect at time of going to press.

you call, read th h di

1 Inyour game, go to Main Menu > Options > Bonus > Unlocking information and write
down the Bonus Access Code. You need this to access the Bonus Codes

2 Log on or call the Hintline on the number above and follow the directions to the ToCA
Race Driver™3 area.

3 When requested, enter the Bonus Access Code you obtained in Step 1.

4 If you're b ying the Codes online (paid by credit card / PayPal), the full set will be
emailed to you. I you are calling the Hintline, write down the codes as they are read
to you; you can access as many or as few Bonus Codes in one call as you like.

& To unlock the Bonuses, go to Main Menu > Options > Bonus and enter the Code/s

you’ve been given.
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About P otosensitive Seizures

A very small percentage of people may experience a seizure when exposed to certain visual
images, including flashing lights or patterns that may appear in video games. Even people who
have no history of seizures or epilepsy may have an undiagnosed condition that can cause these
photosensitive epileptic seizures” while watching video games.

These seizures may have a variety of symptoms, including lightheadedness, altered vision, eye or
face twitching, jerking or shaking of arms or legs, disorientation, confusion, or momentary loss of
awareness. Seizures may afso cause loss of consciousness or convulsions that can lead to injury
from falling down or striking nearby objects.

Immediately stop playing and consult a doctor if you experience any of these symptoms. Parents
should watch for or ask their children about the above symptoms—children and teenagers are mor
likely than adults to experience these seizures.

The risk of photosensitive epileptic seizures may be reduced by sitting farther from the television
screen, using a smaller television screen, playing in a well-lit room, and not playing when you are
drowsy or fatigued.

if you or any of your relatives have a history of seizures or epilepsy, consult a doctor before playing.

Other Important Heaith and Safety Information The Xbox Instruction Manual contains important
health and safety information that you should read and understand before using this software.

Avoid Damage to Your Television

Do not use with certain televisions. Some televisions, especially front- or rear-projection types,
can be damaged if any videa games, including Xbox games, are played on them. Static images
presented during the normal course of gameplay may “burn in” to the screen, causing a permanen
shadow of the static image to appear at all times, even when video games are not being played.
Similar damage may occur from static images created when placing a video game on hold or
pause. Consult your television owner’s manual to determine if video games can be played safely
on your set. If you are unable to find this information in the owner’s manual, contact your televisio
dealer or the manufacturer to determine if video games can be played safely on your set.

Unauthorized copying, reverse engineering, transmission, public performance, rental, pay for play,
or circumvention of copy protection is strictly prohibited.
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Left trigger Right trigger
Y button
Left ik B button
Thumbstick X button
BACK button— A button
START button — Blaf:k button
White button
Directional — — Right
pad thumbstick

Brake —I ’——— Accelerate

Gear Up
St?er R Handbrake
Left Right Gear Down
Look Behind
Boost

Pause Menu —
Change Camera

Look Left Right

en N i tion
Highli ht Menu Item: Directional pad or left thumbstick
Change menu option where available: Directional pad or left thumbst ck
Select highlighted menu item: or @

Cancel/exit menu orQ

Pl yer P ol

Oncethe a ehasloa ,
You will need to createane p o1

rea in e Profile

First select a save slot to store your profile in. As you continue throu hyou drivin  a s
all of your progress and the features tha you have unlocked will be save to th’s profile

Next set up your profile details and then select ‘Done’. Finally complete y ur p o ile by
defining your game options (see Options for more information). When you ave finished,
select ‘Begin’ to start your career.

ur in a

This is your chance to make a name for yourself in the racing world. Along the way you
will take part in a wide range of very different championships featuring a wealth of cars,
each providing unique challenges.

Success will not come easily. Not only will you have to adapt to very different racing styles,
you will also have to be aware of other drivers who want to claim the crown for themselves.

The World Tour mode is where it all starts
and making your way up the career ladder
is one of the ways that you can unlock more
vehicles and tracks that you can then use in
the other game modes.

In Pro Career mode you earn cups for
winning each of the championships.
One cup is awarded for completi t e
championshipinnormal mode, one for hard
mode and one for setting the fastest lap o
each of the tracks in that championship
(Time Trial only). These cups can then be
used to unlock additional bonus content. It
Is also possible to unlock Championships
by ompetingin on-line races.



Lap Indicator:

Position Indicator:
Current Time Indicator:
Lap Time:

Best Time:

Accelerator/Brake Gau e:

G Meter:
Gear Icon
Fuel Gau e:
Speed:
Mini Map:

Sta e Pro ress:

Number of laps completed sa far

Your current position in the race

The tatal race time elapsed sa far

Theti eelapsedso far onyaur current lap
Shows your record lap time for the current track

The amount of force applied to the
accelerator/brake pedal

Shows the amount of g-force currently being generated
Your currently selected gear

The amount of fuel remaining in your tank

Your speed in miles per hour

Your positian and the position of your nearest
competitors on the current circuit Your car appears as
anarrow

Shows your progress through the Rally Stage

Split Time: Represents the fastest recorded time through each
section of the rally. If it’s green you are currently the
fastest, if it’s red then a quicker time has been recorded.

Rally Corner Indicator: Indicates the direction of the road ahead.

Dama e Indicator: Tlluminates fram yellow (minimal) through to red
(serious) as components of your car start to become
damaged. You are able to repair your car in the Pits
(where available) but if your car becomes seriously
damaged to the point that you are unable to complete
the race, you can opt to retire (via the Pause Menu).

Although all vehicles suffer damage they are all affected differently. For example
Open wheel cars are much more fragile and more susceptible to damage to their tires and
wheels. Trucks on the other hand are much more robust and can take much more punishment
It1s important to be mindful of these differences and adapt your racing style accordin ly

NOTE: If you receive terminal damage and components can no longer fun tion the you
are automatically retired from the race



Damage to your gearbox can prevent your car from reaching its top speed.
Damage to this component can also reduce your ability to change from gear
to gear. The gearbox can be damaged by either the player changing down
incorrectly through the gears (in manual mode), or by a head on impact.

1

Steering damage will reduce vehicle responsiveness. Severe damage will
cause the vehicle to pull in one direction, making it difficult to control at
high speeds. The steering can be damaged by front or side-on impacts, or
by driving the vehicle across the infield at high speeds.

I

Suspension damage will affect road holding and cornering ability
Severe damage will increase the possibility of the car bottoming out
The suspension can be damaged by the vehicle being involved in impacts or
by the player driving the vehicle across the infield areas at high speed.

I

Engine damage will seriously reduce vehicle performance, reducing top
speed and acceleration. Engine damage occurs during collisions and once
damaged, the time taken for the engine to overheat will decrease. A bar
underneath the engine icon shows its current temperature.

Damage to the wheels reduces the stability and handling of the car. The loss
of a wheel can lead to you being unable to complete the remainder of the
race. A bar underneath the wheel icon shows the current tire temperature.

TI

As tires wear down they begin to lose grip on the track surface. Driving
across the infield will wear down tires faster and should be avoided.

The anMeuis he o

Simulation de asbel , . .
lateronpa es12&l4. old o 1 - «
to another with less emphasis nr | s r -

an indivdual motorsport a atime.

i Ia io odes
In the Simulation Menu you can choose fro  the following options:

Free Race: This mode allows you to play throu h any of the Champio ships
that have been previously unlacked in World Tour or Pro-Career mode. In Free Race
you can set up the Champianship to your own specification, down to the sm Hest
of details such as selecting which tracks to race an, which rules and fla s will be
used, which opponents to race, etc. You can also switch on full race events, and play
thraugh the entire Race Calendar for that Championship, including all of the practice
and qualifying sessions.

eleect Di cipline: Scroll left or right to select which discipline you want to
race in Above each discipline is a description detailing what sort of racing to expect

ampionship Select: After selecting the discipline you are now

ready to start setting up your Championship. Scroll left/right to select the type of
Championship that you want. You can then select which tracks you would like to race
on, or select to race on the entire calendar. Once you are happy with the selected
tracks you can choase which car you would like to use.

Championship Set-up: Having ele tedthetype of race, the track
and the car, you can adjust the finer details of your Championship. Here you can
et which rules or flags you wish tohav as [lasthe mbe of laps, haw many
opponents will be competing with you nd how you want the gr d position to
be determined.

Time Trial: Use Time Trial to set your best lap times on any of the cir uits that
you have untocked from any of the Championships.

Multiplayer: Achancetoplay enany of the circuits in two-player split-screen
mode Both players need to press ojointhe ame, then Piayer 1 selects the aptions
asinFreeRa mod . The race commences once Player 2 has selected their car.



in
elect ‘System Link’ to start a multi player race against other players on linked Xboxes.
The following options are available:

Join: Enter the lobby of a game that has been created on another linked Xbox
console. Change your car, team and driver if you wish and once you are happy with
your selection press  to ready yourself. Once the host has selected ‘Ready’ anyone
who is not ready will have 15 seconds to press ready before the race begins.

Create: Make your own multi player session using the options on the Session
Settings screen. Once you are happy with all the settings select ‘Start Session’. Your
game will appear on the session list of any linked Xbox for other player to join as
above. You can change the session settings and which championship to race on and
which cars to use from the lobby menu, by returning to the Session Settings menu.

When you are ready to hit the track, select ‘Ready’. This starts a 15 second
countdown to race start, visible on all players’ screens. Players who do not select
ready before the countdown ends will be left out of the race.

System Link Options: Use the System Link Options menu to redefine your
name and to de/activate or define voice output.

e O a i ™ nd

Xbox Live* is a high-speed or broadband Internet gaming community where you can create
a permanent gamer identity, set up a Friends list with other players, see when they’re
online, and receive invitations to play games. For games with multiplayer mode, invite your
Friends to play, and talk to them in real time as you play

onne ti

Before you can use Xbox Live, you need to connect your Xbox consale to a high-speed or
broadband Internet connection and sign up for the Xbox Live service. To determine if Xbox
Live 1s available in your region and for information about connecting ‘to Xbox Live, see
www.xbox.com/connect.

Select ‘Xbox Live’ to take part 1n a multiplayer game on Xbox Live. You must previously
have created an Xbox Live account and Gamertag. Refer to the instructions supplied with
Xbox Live for information on how to do this.

Use ‘Select Account’ to choose an existing Gamertag and proceed, or ‘New Account’
return to the Xbox Live Dashboard and create a new accoun .

cuec .
finds the
displayed  ‘'Find

OptM t h™: Dpti
would like to join. Use the navi a 10
search, and then select “Sear ' odisplay ali
preferences. Highli hta meontheOpti a chResultssc e
the lobby of that game

Create Sessian- Select ‘Create Session’ the followthe pionsons reen
to set up your own online game for ather players to jein. f you want allow anyone
to take part, select the session type ‘Public’. However if you only want players fro
your Friends Lists to join the game make it a ‘Private’ session and invite other players
to join

Lobby: Before the start of an Xbox Live race all players enter the lobby to prepare.
From here you can choose your team/car. The host can also dec’de whether they
want Full Race Rules and Flags to be used in the session or not. Once you are happy
with all the selections that you have made select ‘Ready’ to indicate to the host of
the game that you have finished setting everything up and are raring to go. If any
players are not ready 15 seconds after the host has selected ‘Ready’, the game will
begin regardliess of whether other players have selected ‘Ready’ or not.

Spectator Maode: If youjoin a game se sion where others are already
racing you can wat h the progress of their race by pressing

Driver Rating: If youtake part in a game that has been set up as a ‘Rated
Game’ by the hest  our performance in that game will contribute to your driver
rating and thi inturn will affect our position on the leader-board

14

RN



ro il p c: i -t -] n

t [s 3]
Select Profile to give yourself a name that can be used in career and other race modes.
You can also select which language you want the game to be displayed 1n as well as Soun : ! o
your nationality. so n  emen
type(m o,he 0
rii Bonus: Select Bonus oente orac iv tean Bonus

Cod syouhave. ethebackof he n alfor

Select ‘Driving’ to define your driving style and controller preferences. how to obtain the e codes.

Xbox Live Options: Change ny of the available Xbox Live options.

Control Assignments: Tore define a control, highlight the function
and pressthe  button. Then press whichever
button you want to re assign to that function. If
at any point you want to restore everything back
to the default settings press the ©.7 button.

Advanced: Adjusts your controller’s dead zone and
saturation settings.

Vibration: Turn vibration on or off.

Gearbox: - Select ‘Automatic’ and gears will change
automatically - great for novices.

- Select ‘Manual’ to give you full control over
when you change gear.

- Select ‘Manual with Clutch’ for complete
driving control - For very experienced drivers.

Pro-Simulation: Turning on any of the Pro-Simulation handling
options makes the whole driving experience
much more realistic and therefore much more
difficult. These options should only be turned o
if you are a very confident driver.



v rie

World Tour mode offers you a motorsport career taking you through a wealth of different
championships. Your career will begin with the chance to compete in one of two opening
motorsports on offer: the Global GT Lights and the Autosport Clio Cup. Success in these
championships will enable you to climb the career ladder, getting an opportunity to take
part in a diverse selection of motorsport such as the British GT, DTM and V8 Supercar
Championship Series. Success in these will ultimately provide you with the chance to drive
for the BMW WilliamsF1 Team

t ic
Rick will manage you as you make your way through your career.
He will keep you on your toes and make sure you are getting the best
out of the cars you will be competing in. Whilst you are racing he will
keep in contact with you through the pit radio, letting you know about
any problems and relaying important info to you. Be warned though,
Rick doesn’t pull any punches! He will tell it to you just how it is, so
the only way to keep him happy is to keep on winning all of those
Championships!

ie s
The mode consists of multiple tiers Within each tier you have
several championship options to choose from. There is always a
choice of at least two championships and in most cases there
are three. There is an exception to this rule; the last two tiers
consist of championships featuring WilliamsF1 challenges
where there are no other choices.

InWorld ouryouc rp

you have already unlocked. no de

of the objectives on the previouson .0 e o
itin other game modes.

ha in i

All of the main championships featured in the ame a e in he World Tour mode T e
championships do not all feature the full race calendars and formats. If ou want to play
races with full Calendars and rules head over to the Pro Career mode.

i to

If your car is suffering from damage or you are running low on fuel it is time to come
into the pits. For each repair there is a time allocated so you can see how long it will take.
In addition an overall pit stop time is given. You can alter the time of the pit stop by
changing the level of repairs and how uch fuel is going into the car. In certain
Championships there will be mandatory p~ sto s. This means that you must come into
the pits to either change your tires or refuel Rick will tell you which laps you should
come inon



The Pro Career mode allows you to pick a motor racing discipline and play through each nFreeRaceandProCa --rme P e B is h
championship in a realistic manner with full race rules, calendars, flags etc. o th flagsuse in he-a ea d . - - fe la d

withthem anbe urn dono o + e -

The classic discipline allows you to compete 1n  ome of the most famous
racing cars ever raced. From the 1930s championship winning Mercedes
W25 to the powerful muscle cars of the ‘70s.

. Race some of the most prestigious and exotic sports cars in the GT
ﬁ’@ discipline Take part in mu!ti-class races, and get to grips with some of the
most powerful racing cars in the world of maotorsport

From dirt ovals, to the legendary Indianapolis Motor Speedway, experience
the excitement of the world’s fastest professional motor sport

The Touring Car discipline is about aggressive, high-octane, pack racing.
Ultimately aiming to earn a place in either the DTM or V8 Supercar
Championship Series

From Rally, to Baja, Nissan Dakar to Rally Cross, experience every level of
Off Road racing in the Off Road discipline. The challenge in this thrilling
style of racing is to not only master your vehicle, but also the environment.

Perhaps one of the most technically difficult disciplines, Open Wheel
demands that rivers fully understand the nuances of each track and
vehicle The secret here is all about the racing line, and taking great care to
avoid contact in these fragile machines.

Compete in aseries of time trial events at the 400 acre Be ford Autodrome
Complex Each event takes place in a different car and circuit at the site.

This discipline features a selection of unique and challenging
Championships, pitting players in a number of different Honda cars
and vehicles

Commonly referred oas he passin 1
be aware of a faster car attemptin tola them.

The black flag indicates that the driver h s received ei er a timed or pi
penalty

The yellow flag is displayed as a warning of an accident ahead. Overtakin
1s forbidden whilst this flag is displayed.

The green flag (waved after yellow) signals the end of a aution period.
Drivers can resume to race speed.

The white flag indicates that the driver has commenced their last lap of
the race or can mean (in certain championships) that there is a much
slower vehicle on the sector o track controlled b that flag post.

A black and white diagonally divided flag is shown to drivers for
unsportsmanlike behaviour on the track, such as careless driving or
corner cu ting.

A black fla with an orange circle is s own to drivers whose vehicles have
mec anical problems. DOrivers shown this flag must return to the pits as
soon as paossible.



In Time Trial, Free Race and Pro-Career modes you can tune your vehicle to adjust its
performance. Although races can be won by just using the standard settings in arder to
set the ver best lap times you may find that you need to tweak your settings slightly. If
you press  after selecting any of the components, you will be provided with a detailed
description of the ways in which they affect your car.

Note: Car Tuning is not available in all Championships and not all set-up options will b
available to all vehicles.

Downforce: Downforce is created when air is channelled over the vehicle body.
Downforce increases grip, but also increases drag, which can reduce top end speed.
To adjust dewnfarce highlight the front or rear of the car and use the left thumbstick
or directional pad to adjust the setting of each.

Transmission: Inorder to get the best acceleration the gears need to be set
very close together, this however reduces the car's top speed dramatically.
Inturn spacing the gear ratios out improves the cars top speed but greatly reduces
acceleration. To adjust your gears highlight each one individually and adjust its values

Anti Roll: Ananti-roll bar is a metal bar that links both wheels on the same axle
to the chassis making it harder for the driver-side and passenger-side suspensians
to move in oppasite directions. This reduces the vehicles roll and greatly increases
its grip. To adjust anti roll highlight the Front or rear of the car and use the left
thumbstick or directional pad to alter the setting of each.

Tire Compo nd: Tire compound is a measure of how hard or soft the tire is.
Softer tires afford more grip but wear out quicker and provide slightly less steering
response. Harder tires produce less grip but last much longer and give slightly
better steering response. To adjust your tire compound move the slider left ar right
depending on whether you want it to be hard or soft.

Tire Profile: Tire profileis the measurement from the outer edge of the tire to
the inner rim Campared to conventional passenger car tires, low profile car tires
have greater width ratio to cope with the demands of higher performance vehicles.
To adjust your tire profile highlight the frant ar rear of the car and use the left
thumbstick ar directional pad to adjust its values.

Brake Bia : Adjusting brake bias affects the way that your vehicle handles in
the bends. When you decelerate, the weight of your car is forced forwards onto the
front wheels. This will increase frontal grip but will make the back of your vehicle
light. This can improve steering into tight corners as it will help to shift the back of
the car around, but combined with too much speed it can easily send your car into an
uncontrollable spin.

Cr

br k si

your brake bia
toward the rear or the

Ride eight: A jusin ridehei htc n
suspensian. A hi hride height ivesthe gr-atest -nge
increases the likelihood of body ro!l alon_ withredu ed ownfe &
the ride height, hi hli ht the f ont or rear of the cara « use theleft thumb 1c r
directional pad to adjust the values of each.

Suspension: Suspensian affects the car’s road holdin  abils ies and he ability
to handle cornering at speed. Setting the suspension to ‘soft’ will allow the car to
cope better with uneven surfaces, as each wheel is able to maintain ontact with the
ground for longer. If it is tao soft though, your car will be susceptible to body-roli on
bends. Hard suspension improves your corner taking ability, but on rougher terrain
you will find your grip markedly reduced. To adjust the suspension highlight the
front or rear settings and use the left thumbstick or directional pad to adjust the
values of each.

e and Camber: When the wheels are set so their leading edges are
pointed slightly towards each ather they are said to have toe-in. If they are set
pointing away from each other they are said to have toe-out. Toe settings affect tire
wear, straight-line speed and stability, and there is a trade-off between the straight
line stability afforded by toe-in and the quick steering response promoted by toe
out. To adjust the toe, highlight the front or rear settings and use the eft thumbstick
or directional pad to adjust the values of each.

Cam eris the tilt of ti asviewed from the front of the car. ft etirestilt

t ward the center on the car you have negative camber and if it tilts away from the
center you have positive camber. Adjusting camber can have adram ti effect onthe
steering of the car. To adj sttheca ber, highl” htthe front or rear set ings'and use
the left thumbstick or directi nal pad to adjust the values af each \



In certain Championships you are able to upgrade the various components of the car

Such upgrades increase the overall BHP of the car (at the expense of fuel efficiency), Oil ol
brake strength, engine performance, structural stability, etc. To install the upgrade that
you want, scroll left or right to highlight it and press ~ to install. Below each icon it tells
you how many slots each upgrade will take. The total upgrade slots you have available are
shown in the top left of the screen. If you press ~ on this screen it will provide you with a Roll C g
d tailed description of how the various upgrades affect the performance of the car. t me a
. . Se s: Increase structu al  abilit
Induction Kits: Increase BHP Decrease Fuel Efficiency y
Brake Kits: I brak h Strut races: Increase performance and resistance
rake Kits: ncrease brake strengt to mechanical damage
Bra e Hoses: Increase brake strength Suspensi n Kits: Decrease suspension damage
Cams I < BHP Decrease Fuel Effici Transmission Kits: Increase Gear Speed and performance
H ncrea iciency
Clutches I BHP Turbochargers: Increase BHP - Decrease Fuel Efficiency
H ncrease
Dump Valves I BHP Tires: Increase traction and decrease tire wear
H ncrease
Wheels: Decrease axle and tire damage
Electronics: Increase BHP Increase Fuel Efficiency 8
Engine Tuning: Increase BHP Increase Fuel Efficiency
Engine Hos s: Decrease engine overheating After completing a qualifying
session or tes drive on any track
you can view the telemetry data,
xhausts: Increase BHP Increase Fuel Efficiency which shows your speed at each

part of the track, as well as when
you were applying the brake or
throttle. You can then compare
Flywheel : Increase BHP - Increase Fuel Efficiency data from previous attempts to

find areas where you can improve.

Pressing the  button zooms in
Ignition Kits: Increase BHP Increase Fuel Efficiency s0 you can see the data-in more
detail and the buttan is used
to load the data from previous

Intercool rs: Increase BHP - Decrease Fuel Efficienc attempts



Alan Docking Racing, Audi AG, Barry Pomfret, BMW, Classic Team Lotus, Dallara,
Automobili s.p.a, Daimler Chrysler, Fiat Auto S.p.A, Fuji Heavy Industries Limited,
Gemballa Automobil GmbH, General Motors, Graham Hathaway Engineering Ltd., JC
Bramford Excavators Ltd, JediRacing Cars L.td, John Mills Engineering Ltd, Koenig Specials,
Marcos Sportscars Ltd, MG Sport & Racing Ltd, Mitsubishi Motors Corporation, Morgan,
Mosler Automotive, Nissan Motor Company Limited, Noble Autometive Ltd, Renault
Merchandising SAS, Strana Truck Association of North America, Svanda Metorsports,
TVYR Engineering Ltd., Ultima Sports Ltd, Willia s Grand Prix Engineering Ltd,
4Players BmbH, AS Auto Verlag GmbH and Axel Springer, Dz S.p.A., Prodrive UK, Sparco
SpA, Suncor Energy Products, Nicky Grist Motarsport Ltd, Nimrod Productions.

Bahrain International Circuit, WA Sporting Car Club Inc, Bathurst Regianal Council,
Motar port Visian, Castle Combe Circuit, Donington Park Leisure Ltd, Dover Motorsports
Inc, Eastern Creek International Raceway, Hockenheim Ring GmbH, Gold Coast
Motor Events Co, Mazda Raceway Laguna Seca, Mondello Park Ltd, Matopark GmbH,
Motorspartclub Nurnberg, Nurburgring GmbH, Oran Park Raceway Pty Ltd, PI Operations
Pty Ltd, Melbourne Racing Club, Shanghai International Circuit Co. Ltd, Circuit of Spa
Francorchamps, Exploitatie Circuit Zandvoort b v

Akrapovic d.o.0., Autocar Electrical Equipment, Auto Inparts, Avo Uk Ltd, Cooper-Avon
Tyres Ltd, ThyssenKrupp Bilstein GmbH, Black Diamond Performance, Blitz UK, BMC s.r I,
Brembo S p A, Bridgestone Corp., Components Automotive 73 Ltd, Collins Performance
Engineering, Dastek, Freeman Autamaotive UK Ltd, Heinrich Eibach GnbH, Federal Mogul
Corporation, Fidanza Engineering, Carporation, Goodridge UK LTd, Good Year, Hella, Kont
BV, Leda Suspension Ltd, Max-Torque Ltd, Milltek Spart, Mintex, Omex Technology Systems
Ltd, OMP Racing R.r.I., Pace products (Anglia) Ltd, A&I(Peco) Acoustics Ltd, Penske Racing
Shocks, Pipercross Ltd, Peter Lloyd Rallying, EPTG Ltd / Power Engineering, RT Quaife
Engineering Ltd, Quickshift Racing, Raceparts(UK) Ltd, Red Dot Racing, ReVerie Ltd,
Scorpion Exhausts, SPA Design Ltd, Sparco SpA, Superchips Incorporation, Supersprint,
Toyo Tyre UK, Xtrac Ltd.

1

Frauke Meyer, Christoph Hewer, WM GmbH, The Board Members of the ITR eV
The DTM Championship and all of the teams, drivers, car manufacturers, circuit
and sponsors associated with the series. Tracey Benton, Jenny Babbage, Basil
Scaffidi. The Board Members of V8 Supercar Australia Pty Limited CAN 077 053 484,
Australian VB Supercar Championship and all of the teams, drivers, car manufacturers,
circuits and sponsors associated with the series. Neil Vandegrift and Nicole Polsky,
Indianapolis Motor Speedway
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This produ s uc e
Management Groupof Ame 1 P

Trademarks, desi n paten and op 1
AUDI AG.

The BMW logo, the BMW Williams 1o ,the MW or m rk a
designations are Trademarks of B W AG nd are u ed under license

Dodge is a trademark of DaimlerChrysler Corporation

All Fiat cars, car parts, names, brands and associated imagery featured in his ame are
intellectual property rights including trademarks and/or copyrighted materials of 1at
S.p.A. All rights reserved.

The Buick Gran Sport 455, Chevrolet Silverado, Pontiac Firebird, Corvette C5 and Corvette
CSR are General Motors Trademarks used under license to Codemasters Software
Company Ltd.

Original Music Composed and Arranged by Nimrod Productions Limited
www.nimrodproductians.com

DaimlerChrysler, Three Pginted Star in a Ring and Three Pointed Star in a Laurel Wreath
and Mercedes-Benz are Trademarks of and licensed courtesy of DaimlerChrysfer AG and
are used under license to The Codemasters Software Company Ltd.

Renault Official License Products are vehicle model and trademarks protected by
Intellectual property laws. Used with permission from Renault All rights reserved

General Mators” Vauxhall VX220 and Vauxhall Monaro, all related Emblems and vehicle
body designs are Vauxhall Motors Limited Trademarks used under license to Codemasters
Software Company Ltd.

Trademarks, design patents and copyrights are used with the permission of the owner
Volkswagen AG.

“IRL,” “Indy Racing League,” “IndyCar,” “Indianapolis 00,” “Ind 500,” “Indianapolis
MotorSpeedway” and “ The Greatest Spectacle in Racing” are registered trademarks of
Brickyard Trademarks, Inc., used under license.

Bl “Uses Binii\\/id.eo. Copyright (C) 1997-2005
by RAD Game Toal , Inc.”
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THE CODE ASTERS SO

ARE CO PANY LIMITED

SOFTWARE LICENSE AGR EMENT & WARRAN

IMPORTANT - READ CAREFULLY: THE ACCOMPANYING PROGRAM (WHICH
INCLUDES COMPUTER SOFTWARE PROGRAM, THE MEDIA AND RELATED
DOCUMENTATION IN PRINTED OR ONIC FORM) IS LICENSED TO
YOU ON THE TERMS SET FORTH BELOW, WHICH CONSTITUTES A LEGAL
AGREEMENT BETWEEN YOU AND THE COD SOFTWARE COMPANY
LIMITED. (“CODEMASTERS”). BY USING THE PROGRAM, YOU AGREE TO BE
LEGALLY BOUND BY THE TERMS OF THIS AGREEMENT COoD S.

THE PROGRAM is protected by the copyright laws of the United States,
international copyright treaties and conventions and other laws. The
Program is licensed, and not sold, and this Agreement confers no title or
ownership to the Program or any copy thereof.

. Limited Use License. Codemasters grants you the non-exclusive, non-
transferable, limited right and license to use one copy of the Program
solely for your personal use.

Ownership. Al intellectual property nghts in and to the Program
(including but not limited to video, audio and other ontent incorporated
therein) and title to any and all copies thereof are owned by Codemasters
or its licensors, and you receive no right or nterest there n - ther than the
limited license in paragraph 1 hereof.

YOU SHALL NOT:
Copy the Program.

Sell, rent, lease license, distribute or otherwise transfer or make available
to any other person the Program, in whole or i part, or use the Program
or any part thereof in any commercial context, including but not limited to
use in a service bureau, “cyber cafe”, computer gaming center or any other
commercial location in which multiple users may access the Program.
Codemasters may offer a separate Site License Agreement to permit you to
make the Program available for commercial use; see the contact i i
below.

N

*

.

* Reverse engineer, denve source code, modify, decompile, disassemble, or
create & works of the Program, in whole or in part.

Remove, disable or ci any
on or within the Program.

Export or re-export the Program or any copy or adaptation in violation of
any applicable U.S. expo - restnctions or other laws or regulatons.

LIMITED WAR . Codemasters warrants to the original cons er
purchaser of the Program that the recording medium on which the Progra
is recorded will be free from defects in material and workmanship for 80
days from the date of purchase. If the recording med um of a product is
found defective within 90 days of original purchase, Codemasters agrees to
replace, free of charge, such product within such period upo its receipt of
the Product, postage paid,  proof of th- date of purchase, as long as the
Program is still being manufactured by.Codemasters. In the event that the
Program is no longer availa:le, Codemasters retains the right to substitute
a similar program of equal or g -~ r value. This warranty is imrted to
the recording medium containing the Progra as originall provided by
Codemasters and is not applicable and shall be void if the defect has arise
through abuse, mistreatment, or neglect. Any implied ties prescnbed
by statute are exp essly limrted to the 90-day period described above.

EXCEPT AS SET FORTH ABOVE, THIS WARRANTY IS IN LIEU OF ALL
OTHER WARRANTIES, WHETHER ORAL OR WRITTEN, EXPRESS OR
IMPLIED INCLUDING ANY WARRANTY OF MERCHANTABILITY FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, AND NO OTHER
REPRESENTATIONS OR CLAIMS OF ANY KIND SHALL BE BINDING ON OR
OBLIGATE CODEMASTERS.

*

y notices or label

*

When retumning the Program for replacement p the nal
product disks only in protective packaging andindl - : (1)ap your
dated sales receipt; (2) your name and retum address typed or - -y printed-
(3) @ bnef note describing the defect, the problemy(s) you encountered -+ the
system on which you are running the + (4) if you are retuming the
Program after the 90-day penod, but within one year after the date of
purchase please include check or money order for $15 U.S. currency per CD
or floppy disk replacement. Note Certified mail recommended.

Send to:
Warranty Replacements, Codemasters Inc., PO. Box 1875, Radio City
Station, New York, NY 10101-1875.

LIMITATION ON DAMAGES. IN NO WILL COD S BE LIABLE
FOR SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING
FROM POSSESSION, USE OR MALFUNCTION OF THE PROGRAM, INCLUDING
DAMAGES TO PROPERTY LOSS OF GOODWILL, COMPUTER FAILURE OR
MALFUNCTION AND, TO THE EXTENT PERMITTED BY LAW, DAMAGES FOR
PERSONAL INJURIES, EVEN IF CODE RS HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. COD 'S LIABILITY SHALL NOT
EXCEED THE ACTUAL PRICE PAID FOR THE LICENSE TO USE THIS PROGRAM.
SOME STATES/COUNTRIES DO NOT ALLOW LIMITATIONS ON HOW LONG
AN IMPLIED WARRANTY LASTS AND/OR THE EXCLUSION OR LIMITATION OF
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS
AND OR EXCLUSION OR LIMITATION OF LIABILITY MAY NOT APPLY TO YOU.
THISW GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE
OTHER RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION.

TERMINATION. Without prejudice to any other nghts of Codemasters, this

will i if you fail to comply with its terms
and condrtions. In such event, you must destroy all copies of the Program
and all of its component parts.

US GOVERN ENT and have
been entirely at prvate expense and are provided as “Com
“ . Use, or

by the US. oraUs. is subject
o the set n (X1} of the Rghts in T
Data and in 252.227-7013 or as st
in (cX1) and (2 of the Commercial Co
Rights dlauses at FAR 52.227- 19, as . The Man is

. P0.Box 1875, City Station, New York, NY 10101-1875

INJUNCTION. Because Codemasters would be imeparably damaged if the
terms of this Agreement were not specifically enforced, you agree that
Codemaste: shall be entitied, without bond, other security or proof of
damages, to appropriate equitable remedies with respect to breaches of
this Agreement, in addition to such other remedies as Codemasters may
otherwise have under applicable laws.

INDEMNITY. You agree to indemnify, deferd and hold Codemasters, its
partners, affiliates, contractors, officers directors, employees and agents
harmless from all damages, losses and expenses arising directly or
indirectly from your acts and omissions to act in using the Product pursuant
to the terms of this Agreement.

MISCELLANEOUS. This Agreement represents the complete agreement
conceming this license between the partes and supersedes al prior
agreements and representations between them. ft may be amended only by
awnting executed by both parties. tf any provision of this Agree  ent is held
to be unenforceable for any reason, such provision shall be refo  ed only
the extent necessary to make it an: the p

of this Agreement shall not be affected. This Agreeme shall be construed
under California law as such law is applied to agreements between California
residents entered into and to be performed within California, except as
govemed b federal law and you consentto - exclusive jurisdiction of the
statea d federal courts in Los * geles, California.

If you have any questions concerning this license, you may contact Codemasters at:

The

Limited, PO Box 6,

Royal Leamington Spa, W rwickshire, CV47 2ZT, United Kingdom.
Tel +44 1926 814 132 Fax +44 1926 817 535

Te E -
O -
| ( ) ~eS”e
.cod aste .co

c stservice@codemaste .

© 2005 The Codemasters Software Company Limited Codemasters”). All rights reserved. “Codemasters”®
and the Code asters logo are registered trademarks owned by Codemasters. “Race Driver™™ 3 “Ultimate
Racing Simulator"™ and ‘GENIUS AT PLAY™ are trademarks of Codemasters. Uses Bink Video. Copyright ©
1997 2005 by RAD Game Tools, Inc. All other copyrights or trademarks are the property of their respective
owners and are being used by Codemasters under license. Unauthorized copying, adaptation, rental, lending,
re-sale, arcade use, charging for use, broadcast, cable transmission, public performance, distribution or
extraction of this product or any trademark or copyright work that forms part of this product is prohibited.
Microsoft, Xbox, Xbox Live, and the Xbox and Xbox Live logos are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries and are used under license from Microsoft.



